
Example 7. Modelling of Multiphase Liquid-Liquid Flow in a Static Mixer 

7.1. Introduction and Objectives 

Multiphase flows have a wide range of applications in many industrial areas, such as the 

chemical, pharmaceutical, cosmetic and food industries. One type of multiphase system is 

a two-phase liquid-liquid dispersion, called emulsion. It is a mixture of two liquids that are 

usually immiscible or only partially miscible due to the liquid-liquid phase separation. An 

emulsion is a thermodynamically unstable system because of a natural tendency for a liquid-

liquid system to separate and reduce its interfacial area and energy. However, most emulsions 

are stable over some time, i.e. they demonstrate kinetic stability. There are various ways to 

obtain emulsions, including mixing that can be performed in a particular emulsification device, 

namely a static mixer. Static mixers consist of a cylindrical pipe and a series of motionless 

mixing elements called inserts. There are various shapes of inserts, and their function is to 

induce complex flow fields by redistributing liquids in directions transverse to the main flow. 

Static mixers are an attractive alternative to mechanical mixers. Their main advantages are no 

moving elements, continuous work, small space requirements, and low power requirements. In 

this example, we will investigate the emulsification process with the classical Kenics helical 

mixer. The main objectives of this exercise are as follows: 

 create 3D geometry with application of Sweep, Pattern and Body Operations options, 

 illustrate the setup of the multiphase simulation using Mixture model, 

 visualization of results – contours of volume fraction of both liquids, vectors of velocity. 

 

7.2. Problem Description 

Details of the analysed flow problem are shown in Figure E7-1.  

   

Figure E7-1. Problem description.  
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The fluids involved in emulsification process in this example are the water as continuous 

phase and oil as dispersed phase. The density and viscosity of the oil are equal to 903.1 kg/m3 

and 0.473 Pas, respectively. The volume ratio of the continuous and dispersed phases is 90:10. 

The surface tension at the interface of the two phases is equal to 0.02 N/m. The velocity of both 

liquids at the inlet is equal to 0.1 m/s.  

 

7.3. Geometry 

Open Ansys DesignModeler and go to the Sketching tab. Make sure that Auto Constraints 

options are enabled and setup a proper view by clicking Look At Face/Plane/Sketch. Using the 

Rectangle option draw a rectangle in a way that the origin of the coordinate system will be 

inside this rectangle. Then measure two sides of the rectangle and distances from the X axis to 

the top side of the figure and from the Y axis to its right side (Fig. E7-2a). Enter the appropriate 

values as H2 = 100 mm, V1 = 3 mm, H3 = 50 mm and V1 = 1.5 mm to draw the base of a single 

insert. Set the isometric view (Fig. E7-2b). Go to the Modeling tab and make Sketch1 always 

visible (Always Show Sketch option). Now come back to the Sketching tab in order to draw 

a path along which the insert profile will be swept. Note, that the path must be perpendicular to 

the profile, therefore in the main menu change the plane selecting from the dropdown list 

ZXPlane. The view of the geometry in the Graphics window should be like in Fig. E7-2c (pay 

attention to the axles). Now draw a line along Z axis (it is denoted by red colour in the local 

coordinate system) starting from the origin, measure it (Fig. E7-2d) and set value as 150 mm 

(the insert length). The profile and path needed to create the insert are ready.  

  

  

Figure E7-2. Single insert drawing steps.  



Now select from the top ribbon (or Create menu) the Sweep option. In the Details View 

(Fig. E7-3a) select Sketch1 as Profile, Sketch2 as Path, Add Frozen as Operation and Turns as 

Twist Specification. Since insert is twisted by a degree of 180° enter the value of 0.5 in the 

FD5, Turns field and click generate. The first insert is ready (Fig. E7-3b) 

   

Figure E7-3. Details View of Sweep option and one insert.  

The second insert has to be draw in analogous way with such difference that i) it starts in 

place where the preceding one ends, ii) it is positioned perpendicular to the previous insert and 

iii) it is twisted in the opposite direction. 

The drawing of the second insert should be started by creating a plane in the space where 

the start face of the insert will be located. We know the second insert touch the previous one 

therefore we will create a new plane at the end face of the first insert. In this purpose select 

from the top ribbon a New Plane icon . Now you have two possibilities of drawing new 

plane – starting From Plane or From Face. Here we will use From Plane as a type, therefore 

set the Details of Plane4 as it is shown in Fig. E7-4a. If you want to try From Face type, then 

select this method from the Type dropdown list, choose the Base Face directly from the graph 

and set the Subtype in the details as Tangent Plane. Make sure that the origin of a new plane is 

in the centre of the first insert end face and click generate. The Plane4 is ready (Fig. E7-4b). 

   

Figure E7-4. Details View of Plane4 and a new Plane4.  



On plane 4, draw and dimension a rectangle analogous to the one on the XY plane rotated 

by 90 degrees (Fig. E7-5a). Then create a new plane starting from the ZXPlane in order to draw 

a path along which the profile of second insert will be swept (Fig. E7-5b). 

   

Figure E7-5. Profile and path needed to create the second insert.  

Again select the Sweep option. Details (Fig. E7-6a) set up analogous as previously with 

one difference – since the second insert is twisted in opposite direction enter the value of -0.5 

in the FD5, Turns field and click generate. The second insert is ready (Fig. E7-3b) 

   

Figure E7-6. Details View of Sweep2 option and the second insert. 

The total number of inserts is 6, but each subsequent insert is the same as the first or second, 

so we won't draw them. They will be copied. For this we will use the Pattern option that can be 

found in the Create menu. In the Details View window set up the Pattern Type as Linear, select 

two inserts from the Graphics window as Geometry and Global Z axis with “positive” direction 

as Direction. The axis must be 

selected directly from the 

Graphics window and the copy 

direction can be set by clicking 

on the grey button with black 

and red arrows that will appear 

in the bottom left corner of the 



graphics window. The copy direction will be indicated as in the Fig. E7-7. To shift the copies 

to the correct position, set the FD1, Offset to 300 mm. At the end enter the number of copies in 

the FD3, Copies (>=0) field as 2 and click generate to create four new inserts (Fig. E7-8). 

Figure E7-7. Details View of Pattern option. 

 

Figure E7-8. Six Kenics inserts. 

It was earlier discussed that when we draw 

a geometry of the flow domain our task is to draw 

not the object but the fluid around this object. 

Therefore, now we have to draw a circular pipe – 

cylinder that represents fluid around the elements, 

and then remove (cut) inserts from the volume 

of that cylinder. In order to create cylinder, use 

the Primitives options with details presented in 

Fig. E7-9.  

Figure E7-9. Details of Cylinder1. 

In order to cut the inserts from the cylinder body, 

select from the Create menu the Body Operation. 

In the Details View window set the Type as Cut 

Material and select as Bodies 6 geometries that 

represent the inserts (Fig. E7-10).  Figure E7-10. Details of Body Operation. 



You can select them from the 

Graphics window or from the Tree Outline 

(remember about pressing Ctrl button 

when selecting more than one body). 

Confirm by clicking Generate. Your 

geometry is ready now (Fig. E7-11). If 

everything was done correctly, you should 

see in the Tree Outline 1 Part and 1 Body.  

Figure E7-11. Geometry of the static mixer. 

7.4. Mesh 

Open the Ansys Meshing, rename the geometry as Kenics, and set the Material as Fluid. 

Next, choose the Mesh from the Tree Outline. Ensure that in the Details of “Mesh” the Physics 

Preference is set as CFD and Solver Preference as Fluent, and confirm by clicking Generate 

Mesh. In order to modify the grid from the Top Menu select the Mesh tab and the Method option. 

In the Details of “Automatic Method” – Method dialog box define the geometry. Then from the 

Method dropdown list select Layered Tetrahedrons. The Details window will expand. Enter 

value of the Layer Height as 0.003 m. Click Generate. The mesh is ready (Fig. E7-12). When 

you examine the mesh quality you should see that it is poor, not enough to perform the reliable 

simulation. However, do not change any settings of the grid. In this example you will see that 

sometimes a poor quality of the mesh can be improved in Ansys Fluent. Here, in the last step 

create two Named Selections – Inlet and Outlet.  

 

Figure E7-12. Part of a numerical mesh generated for the Kenics static mixer. 

 

7.5. Simulations 

Open the Ansys Fluent with enabled Double Precision and Display Mesh After Reading 

options and set the Solver Processes as 1. Run down the Outline View Tree to edit subsequent 

parameters and variables: 

 

 



A. Setup – General 

Examine the Mesh → Check and Mesh → Report 

Quality. After selecting Report Quality, you should see 

in the console warning that the minimum orthogonal 

quality is below 0.01, what indicate the poor quality of 

the mesh and can lead to poor results or even to iteration 

divergence. In order to improve the grid quality, select 

from the top ribbon Domain tab and then Mesh → 

Quality → Improve Mesh Quality… as it is shown in Fig. 

E7-13a. A new dialog box will open (Fig. E7-13b), where 

we can define the percentage of cells to be improved and 

number of iterations. Set both these values as 0.1 and 4, 

respectively and click Improve. The results of grid 

improvement will be reported in the console (Fig. E7-14). 

Figure E7-13. Improving the mesh quality in Ansys Fluent. 

 

Figure E7-14. Report of the numerical grid improvement. 

In the General tab set also the Solver Type → Pressure-Based, Solver Velocity 

Formulation → Absolute, Time → Steady.  

 

B. Setup – Materials 

In this example some settings of the models will be connected with a new material that is 

not available in the Fluent Database, therefore in this example before Models we will define 

Materials first. As it was described in the Problem Description two liquids will be used in 

simulation, water and oil. Water (water-liquid material) can be simply added from the Fluent 

Database. The used oil is not available here, therefore you have to add this material analogically 

as it was described in the Example 4, entering the name as Oil, constant value of the density as 

903.1 kg/m3 and also constant value of the viscosity as 0.473 Pas. When both materials are 

added to the Material List you can go to the Models tab in order to define all needed models. 



C. Setup – Models 

The fluid flow in this example is turbulent, therefore from the Viscous Model list select the 

RNG k-epsilon model together with the Enhanced Wall Treatment option. All of the model 

constants left without change. In order to simulate a two-phase liquid-liquid flow, select the 

Multiphase model from the model list. A new dialog box will open where you can select the 

specific model and enter additional options. In the Models tab (Fig. E7-15a) set the Model as 

Mixture, Number of Eulerian Phases as 2, Volume Fraction Parameters as Implicit, Interface 

Modeling Type as Dispersed, and select Slip Velocity and Implicit Body Force. In the same 

Multiphase Model dialog box go to the Phases tab. From the Phases list select phase-1 – 

Primary Phase, set the Phase Material as water-liquid and confirm by clicking Apply (Fig. E7-

15b). Then from the Phases list select phase-2 – Secondary Phase, set the Phase Material as 

oil, define constant diameter as 0.001 m and also confirm with Apply (Fig. E7-15c). Now go to 

the Phase Interaction tab. From the Phase Pairs list select the phase-1 phase-2 and enter the 

following settings as the Force Setup: Drag Coefficient, Coefficient → schiller-naumann, Drag 

Coefficient, Modofication → none, Slip Velocity → manninen-et-al, Surface Tension 

Coefficient → constant with value of 0.02 N/m (Fig. E7-15d). 

  

  

Figure E7-15. Setup of the Multiphase model. 



D. Setup – Cell Zone Conditions 

In this example materials were assigned to the flow domain in the previous step, therefore 

there is no settings that we should enter in the Cell Zone Conditions tab.  

 

E. Setup – Boundary Conditions 

Open the Boundary Conditions Task Page and set the boundary conditions as velocity-inlet 

for Inlet zone and pressure-outlet for the Outlet zone. Then edit the inlet boundary condition 

entering value of the Velocity Magnitude as 0.1 m/s, separately for each phase, as it is shown in 

Figs. E7-16a, b. When you select phase-2 from the dropdown list then the Multiphase tab will 

be activated (Fig. E7-16c). You can enter here a fraction of the dispersed phase, which is equal 

to 0.1 (the volume ratio of the continuous and dispersed phases is 90:10). 

 

 

 

Figure E7-16. Details of the Velocity Inlet Boundary Condition. 



F. Solution – Methods 

Open the Solution Methods Task Page and ensure that the options within this page are set 

up as: Scheme → Coupled, Gradient → Least Squares Cell Based, Pressure → PRESTO!, 

Momentum, Turbulent Kinetic Energy, k, and Turbulent Dissipation Rate, ε, → Third-Order 

MUSCL, Volume Fraction → QUICK and other options are disabled.  

 

G. Solution – Monitors 

Open the Residual Monitors dialog box, make sure that all equations are monitored and 

their convergence is checked. Then set all Absolute Criteria as 1e-7.  

 

H. Solution – Initialization 

Open the Solution Initialization Task Page and initialize the calculation selecting the 

Hybrid Initialization. 

 

I. Solution – Run Calculation 

Open the Run Calculation Task Page and examine your setup selecting Check Case… 

There should be no recommendations here. You can start the calculation by entering 1000 

iterations. During the calculations in the main window you will observe the Scaled Residuals. 

 

7.6. Results 

In order to present the results, a plane must be created passing through the centre of the 

static mixer. In this example, the mid-plane will show both the contours and the vectors of the 

selected parameters. 

 

Contours of volume fraction 

Open the Contours dialog box (Fig. E7-17). 

Set the Contours of as Phases… and Volume 

fraction, and the Phase as phase-1. From the 

Surfaces list select the created mid-plane (here it is 

plane-4). From the Options lists select Filled, Node 

Values, Boundary Values, Global Range, Auto 

Range. The Coloring set up as Smooth. Click 

Save/Display button. 

Figure E7-17. Settings in the Contours dialog box. 



The obtained contours of the volume fraction of continuous phase (phase-1) will be visible 

in the main window. The above contours are presented in Fig. E7-18a. In similar way you can 

create contour of the volume fraction of dispersed phase (phase-2, Fig. E7-18b) just by changing 

in the Contours dialog box Phase from phase-1 to phase-2. 

 

 

Figure E7-18. Contours of the volume fraction of continuous (phase-1) and dispersed (phase-2) phases. 

 

Vectors of velocity 

Double-click the Vectors in the Outline 

View Tree to open the Vectors dialog box 

(Fig. E7-19). Set the Vectors of as Velocity, 

the Phase in two fields as mixture, and the 

Color as Velocity… and Velocity Magnitude. 

From the Surfaces list select the created mid-

plane (plane-4). From the Options lists select 

Global Range, Auto Range, Auto Scale and 

Draw Mesh. By selecting the last option, you 

will open a new dialog box – Mesh Display 

(Fig. E7-20). Here you can set the parameters 

that allow you to visualise the geometry of 

the flow domain together with the simulation 

results.  Figure E7-19. Settings in the Contours dialog box. 



This tool is particularly useful when displaying vectors because, unlike contours, once the 

vectors have been adjusted to the right scale for correct analysis, they do not completely fill the 

analysed area. The geometry view therefore 

makes it possible to unambiguously 

determine the position of vectors in the 

computational domain. In the Mesh Display 

dialog box set the Options as Edges, Edge 

Type as Outline and from the Surfaces list 

select inlet, outlet and wall. Click Display 

and close this dialog box.  Figure E7-20. Settings in the Mesh Display dialog box. 

 

Come back to the settings in the Vectors dialog box (Fig. E7-19). From the Style dropdown 

list you can select one of the available styles. In this example select 3d arrow. Then enter the 

values of Scale and Skip as 6 and 50, respectively. With this option, the vectors will be larger, 

but at the same time the number of vectors displayed will be smaller. In the next step click on 

the Vector Options… field in the Vectors dialog box. This will open the Vector Options dialog 

box (Fig. E7-21), where you should select In Plane option since we 

display the vectors in the plane. You can also change the scale of 

the vector head here and set a specific colour for the vectors, but 

leave these settings unchanged. Click Apply and close this dialog 

box. After enter all the above settings Click Save/Display button in 

the Vectors dialog box in order to display the vectors. They are 

presented in Fig. E7-22. 

Figure E7-21. Settings in the Vector Options dialog box. 

 

Figure E7-22. Basic and close-up views of vectors of the mixture velocity magnitude. 


